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Overview 

Stellar Converter for EDB converts mailboxes from MS Exchange database files into PST files. It allows 

you to convert Online and Offline Exchange database (EDB) to PST files. The software also provides 

preview of mailbox items such as - Emails, Contacts, Calendar, Notes, Attachments, Sent items, etc. 

Key Features of Stellar Converter for EDB: 

 New and enhanced GUI. 

 Support for Global Address List (GAL). 

 Refresh Option for disconnected mailboxes. 

 Filter the scanned results before saving. 

 Added support for conversion of archive mailboxes. 

 Export offline EDB data to live Exchange Mailbox. 

 Search particular mails from the converted file. 

 Convert multiple EDB files. 

 Save converted data in MSG, EML, HTML, RTF, PDF formats. 

 User-friendly and secure software. 

 Converts Online Exchange database (EDB) to PST file(s). 

 Converts Offline Exchange database (EDB) to PST file(s). 

 Supports PUB.EDB files for Offline conversion. 

 Selective conversion of user mailboxes to PST file(s). 

 Supports save option for multiple mailboxes to Office 365 and Online Exchange Server. 

 Supports MS Office 2019 2016, 2013, 2010, 2007, 2003. 

 Supports MS Exchange Server 2016 / 2013 / 2010 / 2007 / 2003 / 2000 / 5.5. 

 Provides preview of mailboxes and mailbox items such as - Emails, Contacts, Calendar, Notes, 

Sent items, Attachments, etc. 



 Compatible with Windows 10 / Windows 8 / Windows 7 / Windows Vista / Windows Server 16 / 

Windows Server 12 / Windows Server 8. 

 Multi DPI supported (100%, 125%, 150%, 175%, 200%). 



System Requirements 

Before installing the software, check that your system meets the minimum system requirements: 

Minimum System Requirements: 

 Processor: Pentium Class   

 Operating System: Windows 10/ 8.1/ 8/ 7/ Vista, Windows Server 2016/ 2012/ 2008 

 Memory: Minimum 2 GB (4 GB Recommended) 

 Hard Disk: 200 MB of Free Space 

 MS Outlook: 2019, 2016, 2013, 2010, 2007, 2003 

Other Prerequisites of Converter for Offline EDB: 

To create the new or existing mailboxes on exchange you have to run the application either on Exchange 

Server or for local system your machine should be on domain of Exchange Server with Administrative 

user rights. 

Create Mailbox Requirements of Converter for Offline EDB: 

Exchange Server Prerequisites 
Exchange Server 2000 Microsoft Outlook 2000 or later 

Exchange Server 2000 Management Tools 

Windows 2000 Administrative Tools 

  

Exchange Server 2003 Microsoft Outlook 2003 or later 

Exchange Server 2003 Management Tools 

Internet Information Server (IIS) 

Windows Server® 2003 SP1 Administrative 

Tools Pack 

  

Exchange Server 2007 Any of the following Microsoft Outlook versions: 

 Microsoft Outlook 2003 

 Microsoft Outlook 2007 

 Microsoft Outlook 2010 

Exchange Server 2007 Management Tools 

IIS 



Microsoft® .NET Framework 2.0 

Microsoft® Management Console (MMC 3.0) 

Windows PowerShell 1.0 

  

Exchange Server 2010 Any of the following Microsoft Outlook versions: 

 Microsoft Outlook 2003 

 Microsoft Outlook 2007 

 Microsoft Outlook 2010 

Exchange 2010 Management Tool 

IIS 6 Management Console 

.NET Framework 3.5 SP1 

Windows Management Framework Core 

(KB968930) including PowerShell 2.0 and 

WinRM 2.0 

  

Exchange Server 2013 Any of the following Microsoft Outlook versions: 

 Microsoft Outlook 2013 

 Outlook 2007 Service Pack 3 with the 

Outlook 2007 November 2012 update 

(12.0.6665.5000) 

 Outlook 2010 Service Pack 1 with the 

Outlook 2010 November 2012 update 

(14.0.6126.5000) 

Exchange Management Tools 2013 

Microsoft .NET Framework 3.5 SP1 or later 

Windows Management Framework 3.0 or later 

IIS 6 Management Console or later 

  

Exchange Server 2016 Any of the following Microsoft Outlook versions: 

 Outlook 2010 

 Outlook 2013 

 Outlook 2016 

Microsoft .NET Framework 4.5.2 or later 

Windows Management Framework 4.0 or later 

IIS 6 Management Console or later 

  



Installation Procedure 

To install the software, follow these steps: 

 Double-click StellarConverterforEDB.exe executable file to start installation. Setup- Stellar 

Converter for EDB dialog box is displayed. 

 Click Next. License Agreement dialog box is displayed. 

 Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

 Click Browse to select the destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder dialog box is displayed. 

 Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog 

box is displayed. 

 Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed. 

 Review the entries. Click Back if you want to change them. Click Install to start installation. The 

Installing window shows the installation process. 

 After completing the process, Completing the Stellar Converter for EDB Setup Wizard window 

is displayed. Click Finish. 

Note: Clear Launch Stellar Converter for EDB check box before clicking Finish to prevent the software 

from launching.  



Launching the Software 

To launch Stellar Converter for EDB in Windows 10: 

 Click Start icon -> All apps -> Stellar Converter for EDB  -> Stellar Converter for EDB  Or, 

 Double click Stellar Converter for EDB icon on the desktop. Or, 

 Click Stellar Converter for EDB tile on the home screen. 

To launch Stellar Converter for EDB in Windows  8.1 / 8: 

 Click Stellar Converter for EDB tile on the home screen. Or, 

 Double click Stellar Converter for EDB icon on the desktop. 

To launch Stellar Converter for EDB in Windows 7 / Vista: 

 Click Start -> Programs -> Stellar Converter for EDB -> Stellar Converter for EDB. Or, 

 Double click Stellar Converter for EDB icon on the desktop. Or, 

 Click Stellar Converter for EDB icon in Quick Launch. 



User Interface 

Stellar Converter for EDB software has a very easy to use Graphical User Interface. The user interface 

contains features required for conversion. 

After launching the software, you will see the main user interface as shown below. You can select either 

of the conversion mode to start the conversion process. 

 

 Hosted Exchange - Hosted Exchange is used to convert online EDB to PST. 

 Offline EDB - Offline EDB is used to convert offline EDB to PST. 

  

  



User Interface - Offline EDB 

Stellar Converter for EDB software has a very easy to use Graphical User Interface. The user interface 

contains features required for converting the corrupt EDB file. 

After launching the software, you will see the main user interface as shown below: 

 

The user interface contains Ribbons, Buttons and Preview Tabs options that let you access various 

features of the software with ease. 



Ribbons 

Home Ribbon 

 

Select EDB File 

Use this option to select the EDB file which you 

want to convert. 

Save 

Use this option to save the converted file. 

Find Message 

Use this option to search for particular mails 

from the converted file. 

Save Scan 

Use this option to save the scan information of 

the converted files. 

Load Scan 

Use this option to load the scan information. 

  

View Ribbon 

 

  

Log Report 

Software records all the events and activities 

performed by you in a detailed log file. Use this 

option to view the log report. 

  

Tools Ribbon 



 

Save Contacts 

Use this option to save the converted contacts 

from the mailbox in .CSV format. 

Update Wizard 

Use this option to check for both, latest minor 

and major versions available online. 

  
Calendar Ribbon 

  

 

Day 

Use this option to list all calendar entries of a 

particular day from the list of the scanned 

mailbox. 

Work Week 

Use this option to list all calendar entries of a 

work week (from Monday to Friday). 

Week 

Use this option to list all calendar entries of a 

week (from Monday to Sunday). 

Month 

Use this option to list all calendar entries for a 

particular month. 

GoTo 

Use this option to list all calendar entries of the 

current date or any particular date. 

  

Activation Ribbon 



 

Activation 

Use this option to activate the software after 

purchasing. 

  

Help Ribbon 

 

Help 

Software is accompanied by a descriptive help 

document. Use this option to view the help 

manual for the software. 

Knowledgebase 

Frequently asked questions and other 

common queries are available as 

knowledgebase for your reference and to help 

you use the software to get the best outcome. 

Use this option to visit Knowledgebase articles 

of stellarinfo.com 

Support 

In case you don't find any related content in 

the help document or on the knowledgebase 

page that resolves your query, use this option 

to view the support page of stellarinfo.com 

and contact the Stellar customer support. 

About 

Use this option to read  information about the 

software. 

Buy Now Ribbon 

http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/


 
  

Buy Online 

Use this option to buy Stellar Converter for 

EDB software. 

Style Ribbon 

 

Use the upward arrow button to hide/ unhide the 
ribbon. 
  
Stellar Converter for EDB, offers the following 
themes: Office 2016 Colorful Theme, Office 
2016 White Theme. Use this option to switch 
between various themes for the software, as per 
your choice. 
  

https://www.stellarinfo.com/email-repair/edb-pst-converter/buy-now.php


Buttons 

 

Click this button to select the EDB file which you want to convert. 

 

Click this button to save the converted file. 

 

Click this button to search the mails through a specific criteria. 

 

Click this button to save the scan information of the converted files. 

 

Click this button to load the scan information. 

 

Click this button to check for both, latest minor and major versions available online. 

 

Click this button to view the log report. 

 

Click this button to activate the software after purchasing. 

 

Click this button to view the help manual for the software. 

 

Click this button to buy Stellar Converter for EDB software. 



 

Click this button view the support page of stellarinfo.com. 

 

Click this button to visit Knowledgebase articles of stellarinfo.com. 

 

Click this button to read information about the software. 

https://www.stellarinfo.com/
https://www.stellarinfo.com/


Preview Tabs 

Stellar Converter for EDB provides options to navigate between Mails, Calendar, Contacts, Tasks, 

Notes, Search, and Journal views at the bottom of the left pane. It also allows to reset/ modify the 

Navigation Pane Options. 

 

 Click on Mail icon to view the mails of the scanned mailbox. 

 

 Click on Calendar icon to view the Calendar functions scanned mailbox. It displays the 

schedules in an organized and efficient manner. 

 



Calendar function also allows to efficiently display the schedule for a day, work week, week, or 

month. 

 

Click this button to list all the entries of one particular day from the 

calendar. 

 

Click this button to list all the entries of a work week (from Monday to 

Friday). 

 

Click this button to list all the entries of a week (from Monday to 

Sunday). 

 

Click this button to list all the entries of a particular month. 

 

Click this button to list all the entries of the current date, or of a 

particular day (any single day except the current date). 

  

 Click on Contacts icon to view the contacts of the scanned mailbox. 

 



 Click on Tasks icon to view the tasks of the scanned mailbox. 

 

 Click on Notes icon to view the notes of the scanned mailbox. 

 

 Click on Search icon to view the specific search results of the scanned mailbox. 



 

 Click on Journal icon to view the created journal entries of the scanned mailbox. 

 

 Click on   and select Navigation Pane Options. This will open the Navigation Pane 

Options dialog box. 

  

To modify/ reset the navigation pane options: 



 

o Check/ uncheck the preview tab that you want to add/ remove from the list. 

o Click Move Up/ Move Down button to modify the order of the preview tabs. Move Up 

button will shift the desired tab upwards and Move Down button will shift the desired tab 

downwards in the list. 

o Click Reset to go back to the default list of preview tabs. 

o Click OK to save the changes. 



User Interface - Online EDB 

Stellar Converter for EDB software has a very easy to use Graphical User Interface. 

 

The user interface contains Ribbons, Buttons and Preview Tabs that let you access various features of 

the software with ease. 



Ribbons 

Home Ribbon 

 

Select Server 

Use this option to connect to the 

online Exchange Server. 

Save 

Use this option to save the converted 

mailbox.. 

  

View Ribbon 

 

Log Report 

Use this option to view the log report. 

Tools Ribbon 

 

Save Contacts 

Click this button to save your contacts 

in a CSV file. 

Update Wizard 

Click this button to check for both, 

latest minor and major versions 

available online. 

  



Activation Ribbon 

 

  

Activation 

Use this option to activate the 

software 

Help Ribbon 

 

Help 

Use this option to view the help 

manual for the software. 

Knowledgebase 

Use this option to visit 

Knowledgebase articles of 

stellarinfo.com 

Support 

Use this option view the support page 

of stellarinfo.com 

About 

Use this option to read  information 

about the software. 

Buy Now Ribbon 

 

  
  
Buy Online 
  
Use this option to Buy Stellar 
Converter for EDB software. 

http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
https://www.stellarinfo.com/email-repair/edb-pst-converter/buy-now.php


  

  

Style Ribbon 

 

Use the upward arrow button to hide/ unhide the 
ribbon. 
  
Stellar Converter for EDB, offers the following 
themes: Office 2016 Colorful Theme, Office 
2016 White Theme. Use this option to switch 
between various themes for the software, as per 
your choice. 



Buttons 

 

Click this button to connect the online EDB file which you want to convert. 

 

Click this button to save the converted file. 

 

Click this button to check for both, latest minor and major versions available 

online. 

 

Click this button to view the log report. 

 

Click this button to save your contacts in a CSV file. 

 

Click this button to activate the software after purchasing. 

 

Click this button to view the help manual for the software. 

 

Click this button to buy Stellar Converter for EDB software. 

 

Click this button view the support page. 



 

Click this button to visit Knowledgebase articles. 

 

Click this button to read information about the software. 



Preview Tabs 

Stellar Converter for EDB provides shortcuts to access Mails and Contacts entries. It also allows to 

reset/ modify the Navigation Pane Options. 

 

Click on Mail icon to view the mails of the scanned mailbox. 

Click on Contact icon to view the Global Address List. 

 



Ordering the Software 

Click https://www.stellarinfo.com/email-repair/edb-pst-converter.php to know more about Stellar 

Converter for EDB. 

To purchase the software online, please visit https://www.stellarinfo.com/email-repair/edb-pst-

converter/buy-now.php 

  

https://www.stellarinfo.com/email-repair/edb-pst-converter.php
https://www.stellarinfo.com/email-repair/edb-pst-converter/buy-now.php
https://www.stellarinfo.com/email-repair/edb-pst-converter/buy-now.php


Activating the Software 

The demo version is just for evaluation purposes and must be eventually registered to use the full 

functionality of the software. The software can be registered using the Activation Key that you receive via 

email after purchasing the software. 

To activate the software: 

1. Run the demo version of Stellar Converter for EDB software. 

2. Go to the Activation Ribbon, click the Activation option. The Activation window is displayed as 

shown below: 

 

3. If you don't have the activation key, click the Get it now button in the window to go online and 

purchase the product. 

4. Once the order is confirmed, an Activation Key will be sent to the email provided. 

5. Type the Activation Key (received through email after purchasing the product) and click 

Activate button (Please ensure that you have an active Internet connection). 

 

6. The software will automatically communicate with the license server to verify the entered key. If 

the key you entered is valid, the software will be registered successfully. 

7. The 'Activation Complete ' message is displayed after the process is completed successfully. 

Click OK. 



Updating the Software 

Stellar releases periodical software updates for Stellar Converter for EDB software. You can update the 

software to keep it up-to-date. These updates can add new functionality, feature, service, or any other 

information that can improve the software. Updates option of the application is capable of checking for the 

latest updates. This will check for both the latest minor and major versions available online. You can 

easily download the minor version through the update wizard. However, the major version, if available, 

has to be purchased. While updating the software, it’s recommended to close all the running programs. 

Note that the demo version of the software cannot be update 

To update Stellar Converter for EDB : 

 Click Update icon from Tools Ribbon. 

 The Update Wizard window will open. Click Next. The wizard will search for the latest updates, 

and if it finds any new updates, a window will pop up indicating its availability. 

 Click Next and the software will download the files from the update server. When the process is 

complete, the software will upgrade to the latest version. 

Live Update may not happen due to the following reasons: 

 Internet connection failure 

 Updates are not available 

 Unable to download configuration files 

 Unable to locate updated files or version 

 Unable to locate the executable file 

Note:  If a major version is available, you need to purchase the software to upgrade it. 



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at http://www.stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/email-repair/edb-pst-

converter/buy-now.php 

Chat Live with an Online technician at http://www.stellarinfo.com 

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to Stellar Support at support@stellarinfo.com 

http://www.stellarinfo.com/support/
https://www.stellarinfo.com/email-repair/edb-pst-converter/buy-now.php
https://www.stellarinfo.com/email-repair/edb-pst-converter/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com


Convert Offline EDB 

 Select EDB File 

 Scan EDB File 

 Save Scanned File 

o Export All Mailbox to Exchange Server 

 How to Create Mailbox? 

o Export Single Mailbox to Exchange Server 

o Export Mailbox in Office 365 

o Save Mailbox to PST, MSG, EML, HTML, RTF, PDF 

o Save Search Results 

o Save & Load Scan Info 



Select EDB File 

To Select an EDB File: 

 Click Select EDB File from Home Ribbon. Select File dialog box opens. 

 Click Browse to select the EDB file that you want to convert. 

 

Stellar Converter for EDB also allows you to find for EDB files in your computer's hard drive, in case you 

don't know their location. 

To Find an EDB File: 

 Click Find in Select File dialog box. Browse for Folder dialog box opens. 

 After the search is complete, list of EDB files found in the selected drive / folder is shown in Select 

File dialog box as shown below: 



 

 Select file you wish to convert from this list and click Next. 

Note: Maximum of 4 files can be scanned at a time using both options - Find and Browse. 



Scan EDB File 

 After selecting the EDB file that you want to convert, click Next. 

 Once scanning is complete, you can preview the data of the scanned file. 

Left pane displays selected EDB filename under Root node in a tree like structure while the Middle pane 

displays the list of converted mails. Click on any mail in the middle pane to see its content, which is 

displayed in right pane as shown below: 

 

Stellar Converter for EDB also allows you to search for particular mails from the scanned file. 

To search for particular mails: 

 Click on Find Message button on Home Ribbon, or select Search from the Preview Tab. 



 

 Enter your criteria for any of the given attributes and then click Search  to search for mails. 

However, you can only select one EDB at a time to search for mails. In order to modify the criteria, 

click Reset and enter the details again. 



Save Scanned Files 

Repaired files can be exported/ saved to various formats. 

 Export All Mailbox to Exchange Server 

o How to Create Mailbox? 

 Export Single Mailbox to Exchange Server 

 Export Mailbox in Office 365 

 Save Mailbox to PST, MSG, EML, HTML, RTF, PDF 



Export All Mailbox to Exchange Server 

To export mails to Live Exchange Server: 

1. Click Save button in Home Ribbon. A dialog box opens. 

2. Select Live Exchange checkbox and click Next. A Enter Login Credentials dialog box opens. 

3. The dialog box requires the following fields: 

 Server Name: Enter the name of the Exchange Server. 

 Admin Email ID: Enter the administrator email id for the Exchange Server. 

 Password: Enter the password of the administrator login id of the Exchange Server. 

 Server Version: Select the Exchange Server version from the drop-down ribbon. 

Click OK to continue. 

 

4. Map Mailboxes dialog box opens displaying mapped and unmapped mailboxes. The dialog box 

consists of the following options: 

 Source Mailbox: Source Mailbox provides a list of scanned mailboxes from the 

converted EDB file. You can search for a specific mailbox to be mapped to a particular 

destination mailbox. 

 Destination Mailbox: Destination Mailbox provides a list of scanned mailboxes on the 

Exchange Server. You can search for a specific mailbox that has been auto-mapped to a 

particular source mailbox. 



 Advance: Click Advance to filter the scanned results before saving. 

 Create Mailbox: This option allows you to create a new mailbox to map any user. To 

know the steps to create a new user, click here. 

 Click "Map Mailbox" in the dialog box to select/ change the destination mailbox. 

 

Check/ Uncheck the desired user mailbox and click Export button to start exporting the data. 

Note: 

 Check the Auto Map checkbox if you want mapping to be done automatically. To map 

the mailboxes manually, uncheck the Auto Map checkbox. Auto Map automatically 

maps the source mailbox to destination mailbox, if found on the destination server with 

the same name. 

 Click on Map Mailbox to select/ change the destination mailbox in Map Mailbox dialog 

box. 

 The server version selected while logging to Live Exchange Server should be similar to 

that of the system on domain. 

 Mailboxes in blue are mapped mailbox and mailboxes in red are unmapped. 



5. The mapped and unmapped source EDB mailboxes are listed. 

Note: Full-Mailbox permissions are mandatory for the user to whom the data is being exported. 



How to Create Mailbox? 

1. Click Create Mailbox to create a new mailbox for mapping. 

2. Click Create New. Enter the User Name to be created. Click OK. 

 

3. Select the desired users to be created. Click OK. 

 



Note: In order to export data, the user should have the full data access rights. 

4. The user's mailbox will be created successfully. Click OK. 

 

Note: 

 The fields that can be edited are : Full Name, Alias Name, Password, and Mailbox 

Database. 



 

 The fields that can not be edited are : Mailbox Domain. 

4. In order to enable the user's mailbox, click Enable Existing.  Disabled users will be listed. 

 

5. Check the users you want to enable again. Click OK. 



 

6. Confirm the checked users and click OK. The selected users mailbox will be enabled 

successfully. Click OK. 

.   

Note: 

 Enable Existing is to be used when a specific user has been disabled before. 



 In case of enabling an Existing mailbox only the Mailbox Database field can be changed 

(you can change the destination Mailbox Database) of the mailbox. 



Export Single Mailbox to Exchange Server 

To save converted mails to a particular mailbox on Exchange Server: 

 Right Click on the tree item which you want to export and select Export to Exchange Server. 

 

  

 In Enter Login Credentials dialog box, enter the Mailbox Name and Server Name. Click OK. 

Note: 

o By default, the MS Exchange Server 2010 and higher checkbox is unchecked. 

o If you are using Exchange Server 2010 and higher, keep the MS Exchange Server 

2010 and higher checkbox checked. 



. 

Note: In order to export data by right clicking on the mailbox, the local system should be in the domain of 

the Exchange server on which you are exporting the data. 



Export Mailbox to Office 365 

To export mails to Office 365: 

1. Click Save icon in Home Ribbon. Save dialog box opens. 

 

2.  Select Office 365 checkbox and click Next. A Enter Login Credentials dialog box opens. 

3.  Enter Admin ID (user having administrative rights) and Password in Enter Login Credentials 

dialog box. Click OK to continue. 

 

4. The mapped and unmapped source EDB mailboxes are listed. 



 

5. In order to manually map the mailbox or change the mapped mailbox, click on Map Mailbox. The 

screen displays all the Office 365 ids that can be mapped. Click OK. 

 

Click Advance to filter the scanned results before exporting. 

Note: 



 You need to have a Microsoft Office 365 user account for exporting data to office 365. 

 To save mailbox data in office 365 you need to install office 2016  or office 2013 or office 2010 

with service pack2. 

 For  Domain systems, you  cannot export offline data to office 365. 

 After mapping, the list displays the E-Mail IDs, of the same domain that was used while logging. 



Save Mailbox to PST, MSG, EML, HTML, RTF, PDF 

Stellar Converter for EDB allows you to save the converted files in various formats like PST, MSG, EML, 

RTF, PDF, and HTML. 

To save the converted files: 

 Click Save from Home Ribbon. 

 Select the required format and click Next. 

 Browse the destination in the Select Destination dialog box where you want to save the file. Click 

OK. 

 

Click Apply Filter to filter the scanned results before saving. 

Using Stellar Converter for EDB, you can save individual mailboxes in either of the given formats. 

To save mailboxes or mailbox item individually from the tree in the left pane, simply right-click on 

it and: 

 Select Save as PST to save the mailbox in PST format. 

 Select Save as MSG to save the mailbox in MSG format. 

 Select Save as EML to save the mailbox in EML format. 

 Select Save as HTML to save the mailbox in HTML format. (Attachments cannot be saved, 

however, their names are visible) 

 Select Save as RTF to save the mailbox in RTF format. (Attachments cannot be saved, however, 

their names are visible) 



 Select Save as PDF to save the mailbox in PDF format. (CC of the mails is not shown and 

attachments cannot be saved, however, their names are visible) 

 Select Export to Exchange Server to export the mailbox to exchange server. 

 Select Export to Office 365 to export the mailbox to Office 365. 

 

  

 



Note: You can also right click on a particular mail to save it individually in MSG, EML, HTML, RTF, and 

PDF format from the middle pane. 

 



Save Search Results 

Search results can be saved in PST, MSG, EML, HTML, RTF, and PDF formats after the successful 

search using the Search Criteria option. 

Stellar Converter for EDB allows you to perform the search operation for the scanned mailbox. The 

search operation displays the results as per the criteria specified. The search results are displayed 

depending on Any Criteria or Exact Criteria. You can switch between the view tabs depending on the 

requirements. 

There are 2 different ways to search for the specific results of the scanned mailbox: 

 Click on Find Message button in the Home ribbon. 

 Click on Search icon in the preview tabs. 

The fields that refine the search results are: 

 To : This filter displays all the mails that have been sent to the e-mail id entered. 

 From : This filter displays all the mails that have been received from the e-mail id entered. 

 Cc : This filter displays all the mails that have been marked as cc to the e-mail id entered. 

 Subject : This filter displays all the mails with the entered subject heading. 

 Body : This filter displays all the mails with the entered mail body text. 

 Attachment Name : This filter displays all the mails that have been sent/ received with the 

specific attachment name entered. 

 Importance : This filter displays all the mails that have pre-defined priority level. Select the 

priority level from the drop-down. 

 Item Type : This filter displays all the mails that have been read or unread. Select the type of the 

mail from the drop-down. 

 Date : This filter allows user to specify a starting and ending date for which the user wants to 

include/ exclude the mails for saving/ exporting. 



 

  

After entering the desired criteria, click Search. To reset the criteria, click Reset. 

Note: Data of the currently selected view tab is saved. 

To save search results: 

 Click Save from Home Ribbon. 

 Select the required format from Save Search Results dialog box and click Next. 

 Browse the destination in the Select Destination dialog box where you want to save the file. Click 

OK. 

 

Note: 



 After search is complete, you can right click on messages to save them individually. 

 Close Microsoft Outlook, if open, to save the mailboxes. 

Click Apply Filter to filter the search results before saving. 



Save & Load Scan Info 

With Stellar Converter for EDB for Offline EDB, you can save the scan information of the converted 

files, in case you need to access it at a later stage. 

To save the scan info: 

 From Home Ribbon, select Save Scan. Save Scan Information dialog box displays. 

 Click Browse to select the destination where you want to save the scan info. Click OK. 

 

To load the scan info: 

 From Home Ribbon, select Load Scan. Load Scan dialog box displays. 

 Click Browse to select the location of the .img file from which you want to load the scan info. Click 

OK. 

 



Convert Online Exchange 

 Connect to Single / All Mailboxes 

 Convert Online EDB 

 Grant Full Mailbox Permissions in MS Exchange Server 2003 and 2000 

 Grant Full Mailbox Permissions in MS Exchange Server 2016, 2013, 2010 and 2007 

 Save Converted Files 

 Save Contacts 

  



Connect to Single / All Mailbox(s) 

For Online conversion of EDB to PST Files, you need to connect to mailboxes on Exchange Server. 

To convert EDB from single mailbox on Exchange Server: 

 Click Select Server from Home Ribbon. 

 'Enter Login Credential' dialog box will appear. 

 

 Select Connect to Single Mailbox from Connection Options. 

 Enter Mailbox Name and Server Name (for MS Exchange 5.5 / 2000 / 2003 / 2007) or check the 

Exchange Server 2010 / 2013 / 2016 checkbox to enter Email ID, Server name and password (for 

MS Exchange 2010 / 2013 / 2016) in Microsoft Exchange Server Information section. 

 Click OK. The application will start connecting to the Exchange Server and once the connection is 

established, a window containing name and status (connected / disconnected) of the mailbox will 

be displayed.  



  

To convert EDB from all mailboxes on Exchange Server: 

 Click Select Server from Home Ribbon. 

 'Enter Login Credential' dialog box will appear. 

       



 Select Connect to all Mailboxes on Server from Connection Options. 

 Enter Admin and Server Name (for MS Exchange 5.5 / 2000 / 2003 / 2007) or check the 

Exchange Server 2010 / 2013 / 2016 checkbox to enter Admin Email ID, Server name and 

password (for MS Exchange 2010 / 2013 / 2016) in Microsoft Exchange Server Information 

section. 

 Click OK. Once the application has established a connection with the Exchange Server, a  window 

displays list of all mailboxes and their status with total number of connected / disconnected 

mailboxes. 

         



Convert Online EDB 

Once Stellar Converter for EDB establishes a connection with Exchange Server, a window displays 

mailbox and its status. If you have selected Connect to all mailboxes on server option, the window 

displays a list of all mailboxes and their status with total number of connected and disconnected 

mailboxes. Click OK to close the window and preview the converted file. 

Left pane displays selected EDB filename under Root node in a tree like structure while the Middle pane 

displays the list of converted mails. Click on any mail in the middle pane to see it's content, which is 

displayed in right pane as shown below. 

 



Grant Full Mailbox Permissions in MS Exchange 

Server 2003 and 2000 

In Exchange Server 2003 and 2000, by default even accounts having Enterprise Administrator privileges 

are not allowed to access all mailboxes of the Exchange Server. Even administrators have no right to 

open mailbox on any of the servers. Thus, you can access only mailboxes of your account, even if you 

have full admin, domain admin or enterprise admin rights. This limitation can be overcome by certain 

methods. But these methods can be applied only if they confer with security and privacy policies. We will 

discuss these methods to grant Full Mailbox Permission access rights in detail. 

Access a Single Mailbox 

If you have the proper Exchange Server administrative rights, you can follow the underlying procedure to 

access a single mailbox in Exchange 2003 and 2000. 

 Click Start menu. 

 In Run dialog box, type mmc dsa.msc. 

 Click OK. Active Directory window is displayed. 

 If Advanced Features is not selected, select it in View menu options. 

 In the list of users shown in Active Directory, right-click on the user whose mailbox permission is 

to be given. Select Properties option. 

  

 In the [User] Properties dialog box, click Exchange Advanced tab. 



 

 In Exchange Advanced window, click Mailbox Rights button. [User] Permission dialog box is 

displayed. 

 

 In Permission dialog box, click the user or group whose mailbox is to be accessed. If user is not 

present in the list click Add button. Enter the object name and click OK. 



  

 Select Full mailbox access option under Allow column. 

 Click Apply and then click OK. 

Access to Mailboxes of a Specific Mailbox Store 

If you have proper Exchange Server administrative rights, you can follow the underlying procedure to 

access mailbox on a specific store in Exchange Server 2003 and 2000. 

 Run Exchange System Manager (ESM). 

 Navigate and select required Mailbox Store in the appropriate server object. 

 Right-click on Mailbox Store and click Properties option. Properties dialog box appears. 

  

 Click Security tab option. 



 

 In Properties dialog box, click the user or group whose mailbox is to be accessed. If user is not 

present in the list click Add button. Enter the object name and click OK. 

 Select Full Control options under Allow column. 

 Click Apply and then click OK. 

If Mailbox is on a Specific Server 

If you have the proper 'Exchange Server' administrative rights, you can follow the underlying procedure to 

access mailbox on a specific Server in Exchange 2003 and 2000. 

 Start Exchange System Manager. 

 Navigate to desired Administrative Group and then the Server under the servers node. Right-

click on the selected server and choose Properties option. 



  

 Click Security tab. 

  

 In Properties dialog box, click the user or group whose mailbox is to be accessed. If user is not 

present in the list click Add button. Enter the object name and click OK. 

 Select Full Control under Allow column. 

 Click Apply and then click OK. 



Wait for few minutes depending on number of domain controllers, Global Catalogs and site replication 

schedules and intervals for the changes to take place. 



Grant Full Mailbox Permissions in MS Exchange 

Server 2016, 2013, 2010 and 2007 

If you have MS Exchange Server 2016, 2013, 2010 or 2007 with .Net framework 3.5 or higher, then you 

need to use Stellar Server Console.exe to provide the Full Mailbox Permission to disconnected 

mailboxes. 

To grant Full Mailbox Rights using Stellar Server Console.exe: 

 Launch Stellar Server Console.exe. Login Details dialog box opens. 

   

 After providing Domain Name, User Name and Password, you will get a window with list of 

mailboxes as shown below: 



   

 To select all the mailboxes, press Select All. 

 To deselect all the mailboxes, press Unselect All. 

 To give Full Mailbox Rights to selected mailbox (s), press Add Admin Rights. 

 To remove Full Mailbox Rights from the selected mailbox (s), press Remove Admin Rights. 

Note: .Net framework 3.5 should be installed on the 'Server' to run Stellar Server Console.exe. 



Save Converted Files 

Stellar Converter for EDB allows you to save the converted files in various formats like PST, MSG, EML, 

HTML, RTF,  PDF. 

To save the converted files: 

 Click Save from Home Ribbon. 

 Select the required format and then select the destination where you want to save the file. Click 

Next. 

 

  

 

Using Stellar Converter for EDB, you can save individual mailboxes in either of the given formats. 

To save mailboxes individually, simply right-click on it and: 



 

 Select Save as PST to save the mailbox in PST format. 

 Select Save as MSG to save the mailbox in MSG format. 

 Select Save as EML to save the mailbox in EML format. 

 Select Save as HTML to save the mailbox in HTML format. (Attachments cannot be saved, 

however, their names are visible) 

 Select Save as RTF to save the mailbox in RTF format. (Attachments cannot be saved, however, 

their names are visible) 

 Select Save as PDF to save the mailbox in PDF format. (CC of the mails is not shown and 

attachments cannot be saved, however, their names are visible) 

Note: You can also right click on a particular mail to save it individually in MSG, EML, HTML, RTF, and 

PDF format from the middle pane. 



 

Click on Apply filter to modify the search results for conversion before saving. 

 

  

Note: If the mailbox that you want to save is under Disconnected Mailboxes, you need to grant full 

mailbox permissions to that mailbox in MS exchange server. Once full mailbox permissions are granted, 

right click on Disconnected Mailboxes and click Refresh All. After refresh, Disconnected Mailboxes 

to which the permissions has been granted successfully will be listed in Connected Mailboxes.  



 



Save Contacts 

Save Contact allows you to save your contacts in a CSV file. 

1. Click Save Contacts from Tools Ribbon. Global Address List appears in the left pane of the 

screen 

           

 

2. 'Select Destination' dialog box appears. 

3. Click on Browse to select the destination where you want to save your contacts. Click Ok. 

4. 'Saving Complete' dialog box appears showing the successful saving of the Data. Click Ok. 

Note : The Data will be saved in an excel sheet which you can view by clicking on 'Open containing 

folder' 



Import PST file in MS Outlook 

To import PST file in Microsoft Outlook 2016 / 2013: 

 Open Microsoft Outlook. From File Menu, select Open & Export. 

 Select Import / Export option from the right pane. 

 From Import and Export Wizard window, select Import from another program or file, click 

Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

To import PST file in Microsoft Outlook 2010: 

 Open Microsoft Outlook. From File Menu, select Open -> Import. 

 From Import and Export Wizard window, select Import from another program or file, click 

Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

To import PST file in Microsoft Outlook 2007 / 2003: 

 Open Microsoft Outlook. From File menu, select Import and Export. 

 From Import and Export Wizard window, select Import from another program or file, click 

Next. 

 In Import a File dialog box, select Personal Folder File (PST), click Next. 



 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In Import Personal Folders dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 



View Log Report 

With Stellar Converter for EDB, you can view the Log Report to analyze the conversion process at a 

later stage. 

To view the log report: 

 From View ribbon, Click on Log Report. 

 A Web Page opens up showing the Status of the Log Report. 



FAQs 

1. What is the difference between 'Online' and 'Offline' conversion of EDB to PST files? 

In Online conversion, EDB files on running server are converted into PST files, while in Offline 

conversion, EDB files stored on a local machine are converted into PST files. 

2. What is the difference between an EDB file and a STM file? 

The .EDB file is the main repository for the mailbox data. The STM or streaming media file is used 

in conjunction with the .EDB  file to comprise the Exchange database. Both files together make up 

the database, and as such, they should always be treated as a single entity. Typically, if you 

perform an action on the EDB  file, the STM file is automatically included. The purpose of the STM 

file is to store streamed native Internet content. 

When you install a new Exchange server in an organization, two data stores are created 

automatically: a default mailbox store and default public folder store. Two database files are 

associated with the default mailbox store: 

Priv1.EDB: A rich-text database file containing message headers, message text, and standard 

attachments. 

Priv1.STM: A streaming internet content file containing audio, video and other media that are 

formatted as streams of Multipurpose Internet Mail Extensions (MIME) data. 

The STM file houses Internet content message streams as defined in Request for Comments (RFC 

822), and the EDB file contains messages that are in MAPI format (Rich Text Format). 

When an Internet mail message comes into the Exchange information store, the body of the 

message is saved in the STM file, and the header information (From, To, Cc, Time Sent, and so 

on) is converted to Rich Text Format (RTF), and then stored in the EDB file. 

3. Is the process of converting my EDB files on server into PST files same as the process of 

converting my EDB files on local machine? 

No. To convert EDB files on server into PST, you have to first connect to mailbox(s) on server. 

After the connection is established, you can start the process of conversion. To know how to 

connect to mailboxes, see Connect to Single / All Mailboxes topic of this help. For Offline 

conversion, you simply need to select EDB file and start the process of conversion. 

4. I am not able to find my EDB file, how do I locate it? 



Use Find EDB option to search and locate the EDB files. 

5. I want to convert my Calendars and address book, how do I convert them using Stellar 

Converter for EDB tool? 

First you need to convert mailboxes from the EDB file using the software. refer to How To... section 

of this guide. Then, you can save the Calendars and Contacts folder in the PST format for outlook. 

6. Why do I require to convert EDB files into PST files? 

There are different scenarios when a user may want to convert EDB files to PST files: 

 If a user wants to take backup of mailbox(s) of ex employee(s), before removing them from 

exchange server then user has to convert their mailbox(s) into PST file(s) by using Stellar 

Converter for EDB. 

 If a user needs to check mailbox of any employee for any reason, he has to first convert 

EDB file on server into PST file. Then open this PST file in Outlook to read mails. 

 To take backup of selective mailboxes, a user has to convert EDB file into PST files first. 

These PST files can be used as backup. 

7. How many files can be scanned at one time ? 

Stellar Converter for EDB Offline scans maximum of four files at a time. 

8. What is mapping of mailboxes ? 

Mapping is a feature that automatically loads/subscribe source mailbox to destination mailbox 

having full-mailbox permissions. 



Legal Notices 

Copyright 

Stellar Converter for EDB, accompanied user manual and documentation are copyright of Stellar 

Information Technology Private Limited, with all rights reserved. Under the copyright laws, this user 

manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. 
  
STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar Converter for EDB® is a registered trademark of Stellar Information Technology Private Limited. 
Windows XP®, Windows 2003®, Windows Vista®, Windows 7®, Windows 8®, Windows 10® are 
registered trademarks of Microsoft® Corporation Inc. 



All Trademarks Acknowledged. 
All other brands and product names are trademarks or registered trademarks of their respective 
companies. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



License Agreement - Stellar Converter for EDB 

Stellar Converter for EDB 

Copyright © Stellar Information Technology Private Limited. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Converter for EDB . 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Converter for EDB with which this License is included, you may return the 

complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Converter for EDB. For purposes of this License, if you have a valid single-user license, you have 

the right to use a single Licensed Copy of Stellar Converter for EDB . If you or your organization has a 

valid multi-user license, then you or your organization has the right to use up to a number of Licensed 

Copies of Stellar Converter for EDB equal to the number of copies indicated in the documents issued by 

Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Converter for EDB may either be used by a single person or used non-

simultaneously by multiple people who use the software personally installed on a single workstation. This 

is not a concurrent use license. 

All rights of any kind in Stellar Converter for EDB, which are not expressly granted in this license, are 

entirely and exclusively reserved to and by Stellar Information Technology Private Limited. You shall not 

rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works based 

on Stellar Converter for EDB nor permit anyone else to do so. You shall not make access to Stellar 

Converter for EDB available to others in connection with a service bureau, application service provider or 

similar business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

http://www.stellarinfo.com/


Stellar Converter for EDB and all accompanying software, files, data and materials are distributed and 

provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge that 

good data processing procedure dictates that any program including Stellar Converter for EDB must be 

thoroughly tested with non-critical data before there is any reliance on it and you hereby assume the 

entire risk of all use of the copies of Stellar Converter for EDB covered by this License. This disclaimer of 

warranty constitutes an essential part of this License. In addition, in no event does Stellar authorize you 

or anyone else to use Stellar Converter for EDB in applications or systems where its failure to perform 

can reasonably be expected to result in a significant physical injury or in loss of life. Any such use is 

entirely at your own risk and you would not hold Stellar responsible for any and all claims or losses 

relating to such unauthorized use. 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

  

Copyright © Stellar Information Technology Private Limited. All rights reserved. 



About Stellar 

Stellar Data Recovery is a global leader in providing data recovery, data migration and data erasure 

solutions for the past two decades. Stellar Data Recovery is a customer centric, critically acclaimed, 

global data recovery, data migration & erasure solutions provider with cost effective solutions available for 

large corporates, SMEs & Home Users. Stellar Data Recovery is headquartered in New Delhi, India and 

has a strong presence across USA, Europe & Asia. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

E-mail Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

  

Data Erasure 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/prevent-dataloss.php


Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently erase 

confidential data beyond the scope of data recovery.  You can perform high speed bulk data erasure & 

generate erasure certificates for audit trail purpose. 

BitRaser supports 24 International data erasure standards. More Info >> 

  

For more information about us, please visit www.stellarinfo.com. 
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